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Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License

EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with the Product. The Software is 
licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend the Software 
or use the Software in any time sharing, service bureau, or similar arrangement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to localize, translate, disassemble, 
decompile, decrypt, reverse engineer, discover the source code of, modify, create derivative works of, or in any way change any part of the Software.

The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates, and upgrades related to the 
Software.

Proprietary Rights

You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the Software, Documentation and all 
modifications and derivative works thereof are solely owned by and shall remain with EFI and its suppliers. Except for the express limited license granted above to 
use the Software, no right or license of any kind is granted. You receive no rights or license under any patents, copyrights, trade secrets, or trademarks (whether 
registered or unregistered). You agree not to adopt, register, or attempt to register any EFI trademark or trade name (“EFI Mark”) or any confusingly similar mark, 
URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and not to take any other action which impairs or reduces 
the trademark rights of EFI or its suppliers. 

Confidentiality

The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, however, permanently transfer all of 
your rights under this Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and regulations, 
including the U.S. Export Administration Regulations, (2) you transfer to the person or entity all of the Software and Documentation (including all copies, 
updates, upgrades, prior versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and 
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this Agreement. 

Remedies and Termination

Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software, Documentation, and all component parts thereof. All 
provisions of this Agreement relating to disclaimers of warranties, limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI’s 
proprietary rights shall survive termination.



Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no 
warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or hardware. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI 
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY 
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD 
PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this agreement to the extent that this agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or 
trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE 
WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls

EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as foreign export laws and regulations. 
You agree that you will not use, distribute, transfer, export, or re-export any portion of the Product or the Software in any form in violation of any applicable laws 
or regulations of the United States or the country in which you obtained them.

U.S. Government Restricted Rights:

Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987) 
Alternate III(g)(3)(June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, such data is protected per 
FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 252.227.7015 
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or superceded, the 
subsequent or equivalent regulation shall apply. The name of the Contractor is Electronics for Imaging. 

General

The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of California exclusively, as such laws 
apply to contracts between California residents performed entirely within California. The United Nations Convention on Contracts for the International Sale of 
Goods and any other similar convention does not apply to this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive 
jurisdiction and venue of the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is the 
entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If any provision of this Agreement is held 
invalid, such provision shall be deemed modified to the extent necessary to be enforceable and the other provisions in this Agreement shall continue in full force 
and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics for Imaging
303 Velocity Way
Foster City, CA 94404
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xi About this guide
This guide provides a reference for information about optimizing colour printing 
with the C9800 and improving colour quality and performance for all printer models. 
Specific features and options may vary, depending on the C9800 model at your site.

About this guide
This guide provides an overview of general colour concepts, with a specific focus on 
colour management for print output. It describes multiple scenarios (called workflows) 
during which colour information can be specified, and makes recommendations about 
when to use each type of workflow. It also provides application notes that explain how 
to print to the Fiery from popular Microsoft Windows and Apple Mac OS 
applications. 

The Glossary at the back of this guide defines terms and concepts—for example, 
output profile—that appear throughout this manual. Colour terms and concepts such 
as “RGB data,” “colour space,” “spot colour,” “gamut,” and “source profile” are used 
throughout this guide. If you are new to desktop colour, or if any terms are unfamiliar, 
consult the Glossary near the end of this guide.

For additional information
This guide is one in a set of documentation that includes manuals for both users and 
system administrators. For a description of all the available documentation, see the 
Quick Start Guide. All other manuals should be available at your site; refer to them for 
more information as directed in this guide.

For additional information about the topics discussed in this guide, see:

• Colour Guide—for detailed information about the colour printing options and 
settings available with your Fiery, as well as the ColorWise® colour management 
system built into your Fiery.

• Printing Guide—for information about how to set the ColorWise print options.

• User Software Installation Guide—for information about the software provided 
with your Fiery, including sample colour reference pages used to verify print results.

Introduction



xii Introduction
• Job Management Guide—for information about performing colour management 
tasks and using ColorWise Pro Tools™.

For general information about printing in colour, see Appendix 8 and the sources in 
the Bibliography.



11-1 Understanding colour management systems
To create successful colour documents and presentations, you can take advantage of the 
features of colour management software as they are implemented by the Fiery and on 
your desktop computer. This chapter is devoted to various elements of colour 
management that contribute to predictable colour results.

Understanding colour management systems
A colour management system (CMS) is a “translator” between the colour space of 
the source device (for example, the monitor or a scanner) and the colour space of the 
destination device (for example, the printer). It compares the colour space in which the 
source image was created to the colour space in which the job will be output, and 
adjusts the colours in the document to maintain consistency across different devices. 
A CMS typically uses a device-independent colour space, such as CIELAB, as its 
intermediate colour space. To perform its translation, a CMS needs information about 
the colour space of the source image and the gamut of the printer. This information is 
provided through profiles, often created by the makers of the computer monitor or 
printer. The end product of a CMS conversion is a printed document or an image file 
in the gamut of a particular printer.

There has been progress toward standardization in the field of digital colour 
management systems. Both the Windows and Mac OS operating systems support an 
industry standard format developed by the International Colour Consortium (ICC). 
This ICC format is implemented on Windows computers as Image Colour Matching 
(ICM) and on Mac OS computers in ColorSync. More and more software developers 
are also incorporating colour management systems into high-end applications. 
The Fiery colour management system, ColorWise, supports this standard profile 
format.

How colour management works
Before you can print a colour document, the colour data in it must be converted to the 
gamut of the printer. Whether performed by the Fiery or a host-based CMS, the 
process of converting colour data for a printer is the same: the CMS interprets RGB 

Chapter 1:
Overview 
of Colour 
Management 
Concepts



11-2 Overview of Colour Management Concepts
image data according to a specified source profile and adjusts both RGB and CMYK 
data according to a specified output profile, also called a destination profile by some 
colour management systems.

The source profile defines the RGB colour space of the image’s source—characteristics 
such as the white point, gamma, and the type of phosphors used. The output profile 
defines the gamut of an output device, such as a printer. The Fiery (or the host-based 
CMS) uses a device-independent colour space to translate between the source colour 
space and the colour space of the output device.

The Fiery allows you to specify default and override settings for the source colour space 
information and the output profile information (see the Colour Guide Chapter 1). 
When you use these settings, you do not need to use the features of other colour 
management systems. Your Fiery software includes ICC profiles for use with other 
colour management systems, although conflicts may arise when the Fiery CMS is used 
in conjunction with a host CMS.

You can also use colour management systems to adjust colour data to the gamut of an 
output device other than the one to which you are printing. This process of simulating 
another output device is commonly used for proofing jobs that will be printed on 
an offset press. The Fiery simulation feature is described in detail in Chapter 1 of the 
Colour Guide.

The type of print job and the final output device—Fiery or offset press—determines 
the workflow that allows you to achieve the best results. For information about 
choosing workflows, see “Using Colour Management Workflows” on page 2-1.

Input data Printed data or file

Colour management system

Device-independent 
colour space

Source 
profile

Output 
profile



11-3 Using ColorWise and application colour management
Using ColorWise and application colour management
The Fiery colour management system, ColorWise is designed to provide both casual 
and expert users the best colour output for a variety of purposes. Several applications 
also provide their own colour management system. This guide describes how to 
optimize print output using both ColorWise colour management and application 
colour management.

The Fiery can intelligently manage the printed appearance of RGB, CMYK, and spot 
colours. You can allow the Fiery to manage colour for most colour printing jobs 
without adjusting any settings.

A desktop (host-based) colour management system uses ICC profiles to convert 
colours from one device gamut to another (see Appendix 8). The colour data is 
converted when it passes from one application to another or when the job is sent to the 
printer; thus, the processing occurs on your computer, as opposed to the Fiery.

Conventional colour management systems typically address only colour conversions, 
and they occupy your computer processor. When you use ColorWise, jobs leave 
your computer faster, and are processed more quickly on the Fiery.

The advantages to ColorWise colour management versus desktop (application) colour 
management include:

• Relieving your computer from performing additional processing. Delaying colour 
conversions until the colour data reaches the Fiery frees your computer so that you 
can continue working, and colour conversions on the Fiery are, in most cases, much 
faster than similar conversions on a host computer.

• Eliminating the potential for undesirable colour management-related conflicts, 
such as iterative colour conversions and inconsistent colour. The Fiery applies 
global corrections to specific groups of RGB, CMYK, and spot colours to avoid 
such conflicts.

• Accepting RGB files in addition to larger CMYK files from applications, which 
minimizes network traffic and enables jobs to print faster.



11-4 Overview of Colour Management Concepts
ColorWise uses ICC profiles to convert colours to the device gamut or simulate other 
devices, such as an offset printing press. ColorWise manages colour conversions for all 
users printing to the Fiery from Windows and Mac OS computers. It allows users to 
follow a simple workflow with minimal intervention using robust default settings, 
while giving advanced users the control and precision they need.

Using ColorWise colour management tools
Your Fiery user software includes several types of colour reference pages that allow you 
to see the range of colours that can be printed on your printer. For predictable colour, 
use the colour reference pages when defining the colour in your document.

The resources available are:

• RGB Colour Reference—a Microsoft Word file and a Microsoft PowerPoint file that 
allow you to view the colours available in the standard palettes of office applications 
and to see how those colours print on the Fiery (see “Using colour matching tools 
with office applications” on page 3-2).

• CMYK Colour Reference—an 11-page downloadable PostScript file of CMYK 
colour patches (see “Using the CMYK Colour Reference” on page 4-3). 

• Process Simulation of PANTONE Solid Coated Colours—a 19-page downloadable 
PostScript file of colour patches showing CMYK equivalents of PANTONE Coated 
colours. This file prints differently depending on the setting of the Spot Colour 
Matching option (see “Using the PANTONE reference” on page 4-3). 

In addition, you can print RGB, CMY, and PANTONE colour charts from the Fiery.
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A workflow is the path a print job follows from creation to destination. In the 
workflow of any job, there are various points at which decisions are made about how to 
define, use, and translate colour. The choices made, and the point at which they are 
made, impact the colour output produced.

This chapter introduces issues with colour management in specific desktop 
applications and discusses the interaction between those applications and ColorWise 
colour management.

Understanding workflows
The term “workflow” is used to describe the path a job follows from its creation in a 
desktop application to final printed output. The Fiery supports a variety of workflows 
with different levels of complexity. There are several points at which colour 
management can be performed on a job (see the illustration on page 2-2). The 
information provided at each step (for example, the type of colour used) impacts the 
workflow of the job.

NOTE: Always consider the complexity of the workflow. Every time colours are 
converted, performance and colour accuracy are affected. A workflow with a minimum 
number of steps minimizes the risk of error.

Chapter 2:
Using Colour 
Management 
Workflows
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Application CMS: Off
Disable the colour management options provided by the 
application to ensure that the Fiery receives colour data 
properly and prints it accurately. For information, see the 
documentation provided with your application.

Select colours based on the desired output (see “Choosing 
colours” on page 2-4).

Select file format based on the desired output. EPS data is 
not manipulated.

Use ColorWise Colour Management as described in this 
guide and the Colour Guide Chapter 1.

Printer driver colour options: Off
Do not use the colour management options provided by 
the printer driver. For more information, see the Printing 
Guide Appendix A.

Calibration

Device maintenance

Calibrate as described in the Colour Guide. Perform regular 
maintenance as recommended by the printer manufacturer. 
Use the paper stock, toner, and other materials 
recommended by the printer manufacturer.
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Standard recommended workflow
The Fiery controller is highly optimized for the C9800. ColorWise addresses issues 
unique to your printer, including screens, individual toner response, interactions 
among toners, natural smoothness of blends, and the capability to render spot and 
custom colours. The Fiery distinguishes text and graphics from image elements, so that 
black channel information is preserved while parameters used for CMYK colour 
separations are maintained.

The recommended standard colour workflow uses ColorWise calibration and colour 
management. The Fiery comes into play near the end of the colour workflow. 

For this workflow:

• Bypass any colour management in the applications and printer drivers.

This ensures that the colours you selected reach the Fiery and ColorWise 

in a usable form. Keep in mind, however, that ColorWise fully supports colour 

management from applications and printer drivers (see “Using ColorWise and 

application colour management” on page 1-3).

• Set the CMYK Simulation Profile option in ColorWise to match the CMYK colour 
space used in the application to select the colours. Any CMYK Simulation setting 
(except Match Copy, if available) applies calibration, so the response of the printer 
will appear to be stable.

The recommended values for CMYK Simulation are SWOP in the U.S., Euroscale 

in Europe, and DIC in Japan—choices that reflect the colour standard for each 

region. If colours have been selected specifically for your calibrated Fiery, set CMYK 

Simulation to None.

• Set other ColorWise print options as appropriate. For a list and descriptions of 
ColorWise print options that affect CMYK, RGB, spot, and other colours, see the 
Colour Guide Chapter 1.
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Choosing colours
When working with colour materials, whether they are presentations, illustrations, 
or complicated page designs, you make aesthetic decisions about the colours you use. 
After you set a goal, you must make the best use of the capabilities of your Fiery to 
realize your design in print. Your colour printing system becomes an ally in this 
creative process to the extent that results are predictable:

• If you designed a poster to print on the Fiery, you want the printed colours to match 
the design specification.

• If you are printing presentations on the Fiery, you want to preserve the vivid colours 
you see on your monitor.

• If you are working with colour that is to be printed on an offset press, you want 
the C9800 output to match other prepress proofs or PANTONE colour swatch 
books.

The colours that you define when creating a file in an application, and the colour 
management tools within the application that you use, impact how the file is processed 
(workflow) and the final output you can expect. 

Use colour management to control colour output by:

• Selecting a colour model—different types of applications use different colour 
models. The colour model you select, and whether or when data is converted from 
one colour model to another, influences the final colour output.

• Optimizing for output type—the type of final output influences your colour and 
application choices.

• Using colour matching tools—the Fiery provides several tools to preview colours 
available on a device and define them within an application.
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Understanding colour models
Colours can be defined in several different colour models, the most common being 
RGB, CMYK, and the spot colour matching system (such as PANTONE). Depending 
on the application you use, you may or may not have a choice of the colour model.

• RGB colours are used when you take output from an RGB device such as a digital 
camera or a scanner. Another use of the RGB colour model is for displaying colours 
on a monitor.

• CMYK colours are what most printers use.

• Spot colours, such as PANTONE, are special inks manufactured to run on an offset 
printing press. Spot colours can be simulated using CMYK toners (also known as 
process colour inks). With the Spot Colour Matching print option, you can 
determine how spot colours are printed at the Fiery:

Spot Colour Matching On uses colour tables built in the Fiery to simulate the spot 

colour with the closest equivalent available using the CMYK toners of the C9800.

Spot Colour Matching Off instructs the Fiery to simulate the spot colour using 

CMYK equivalents defined by the spot colour manufacturer. These are the same 

CMYK values used by applications that include spot colour libraries. This CMYK 

combination is then printed with the CMYK Simulation setting you choose, such as 

SWOP or DIC.

The colour model used by your application determines the methods available for 
choosing colours, as well as the way colour data is transmitted to the Fiery:

• Office applications, such as presentation software, spreadsheets, and word processing 
programs, use the RGB colour model. They typically transmit only RGB data to the 
Fiery.

• Illustration applications use both the RGB and CMYK colour models, but typically 
transmit only CMYK data to the Fiery.

• Pixel-editing applications use both the RGB and CMYK colour models. They can 
transmit either RGB or CMYK data to the Fiery.
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Optimizing for output type
The Fiery can be used for on-demand colour printing and for colour proofing. 
On-demand colour printing refers to those jobs for which the C9800 is the final print 
device. Printing jobs to the Fiery in preparation for printing on an offset press is 
referred to as colour proofing. Both types of Fiery print jobs can use RGB, CMYK, and 
spot colours.

NOTE: The term on-demand applies to producing printed output when it is needed. 
You may be familiar with the term short-run, which usually applies to the volume of a 
printing task. Although these terms do not mean exactly the same thing, the term 
on-demand in this manual applies also to short-run printing scenarios. Because you can 
print as many pages as you need and can reprint jobs quickly, the Fiery performs 
equally well in either environment.

The type of printing you plan for the document—on-demand colour printing on the 
C9800 versus colour proofing for eventual printing on an offset press—determines the 
way you define colours, as well as the print option settings you choose.

• For on-demand colour printing on the C9800, use any application and define 
colours in either RGB or CMYK. If your application supports it, you can also 
choose colours from the PANTONE colour library. Choose the appropriate settings 
for print options affecting colour output (for descriptions of the print options, see 
the Colour Guide Chapter 1). 

• For colour proofing, use a PostScript-defined colour in CMYK or choose colours 
from colour libraries such as the PANTONE colour library. Placed images can also 
be defined in RGB or CMYK. Choose the appropriate settings for print options 
affecting colour output (see the Colour Guide Chapter 1).

Characteristics of on-demand jobs Characteristics of offset proofs

Bright, saturated colours are often desirable. Require the printed colours to match 
those from another set of CMYK 
printing conditions.

Colours are achieved using the full range 
of colours available, referred to as the full 
gamut of the printer or, more simply, 
device CMYK.

Colours that are specified for an offset press 
require CMYK simulation that is optimized 
for proofing on the printer.
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NOTE: The Fiery allows you to use RGB or CMYK data when printing proofs for 
an offset press run. However, sending data to an imagesetter usually requires 
CMYK data.

Maintaining colour accuracy
For the colours you see on your monitor to match those on your printed output, they 
must go through colour management, including precise calibration of your monitor 
and Fiery. If viewing colours on the monitor is critical, consider using a professional 
profiling software package and instrument, such as the EFI Colour Profiler, to create a 
monitor profile. A monitor profile enables application to compensate for the colour 
behavior of the monitor when displaying images. As a result, colours previewed on the 
monitor more closely match colours in your printed output.

If you are not equipped or inclined to maintain accurate monitor colour management, 
you can opt for an easier approach. Determine which is more important to you—
printed colours or on-screen colours.

• If displayed colours are more important, trust your eyes and your monitor. Visually 
select colours on your monitor, but be aware that colours will be optimized only for 
your monitor. When the document is opened on other monitors, the colours may 
look different. And even though printed colours may not match those on your 
monitor, they will still print to the Fiery with good results.

• If printed colours are your priority, choose colours from printed samples. By using 
sample colours, you ensure your printed output remains consistent, regardless of 
how the colours appear on different monitors. Print the palette of available colours 
from business applications and select colours from the printed samples. Colour 
reference files are included on the User Software CD. (For more information, 
see“Using colour matching tools with office applications” on page 3-2 and “Using 
colour matching tools with PostScript applications” on page 4-2.) You can also print 
colour charts from the Fiery and select colours by name or number from the printed 
samples. Advanced applications allow you to define colours in the easier-to-control 
spot and CMYK colour spaces. For more advice on colour selection, see “Choosing 
colours” on page 2-4.
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The ColorWise colour management system provides complete colour management for 
jobs printed from office applications and other applications that do not generate 
PostScript. This chapter provides instructions for printing colour documents from 
Graphics Device Interface (GDI) and QuickDraw applications, such as presentation, 
spreadsheet, and word processing applications. Use these instructions with the 
Microsoft Office applications.

Using office applications 
The Fiery must receive PostScript instructions to print an image or a document. Many 
applications do not create these PostScript instructions, relying on the printer driver to 
create them. Included in this category are most word processing, spreadsheet, and 
presentation graphics applications. These applications use Windows GDI to display 
and print when running Windows, and Apple QuickDraw to display and print when 
running Mac OS. We refer to these GDI and QuickDraw applications as “office 
applications.”

All office applications handle colour similarly, using the same RGB colour model used 
for the colour monitor. Most office applications allow you to choose colours from a 
palette of preselected colours; some allow you to add new colours to the palette using a 
colour picker. Although some applications allow you to specify colour using the CMY, 
HSL, and HSV colour models, these applications always send RGB colour data to the 
Fiery. 
(An exception to this is a CMYK EPS file placed in the document, which is sent as 
CMYK data.)

When working with colour in office applications, consider the following:

• The range of colours that can be displayed in RGB on your monitor is much larger 
than the range of colours that can be printed on your printer. When you print the 
document, out-of-gamut RGB colours are mapped to the colours your printer 
can produce.

• Office applications send only RGB data to the Fiery. You control the rendering style 
of the colour conversion with your selection of a CRD.

Chapter 3:
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Each CRD uses a different colour rendering style and has a different way of mapping 
unprintable colours to the colour gamut of your printer. For more information on 
colour rendering styles, see the Colour Guide Chapter 1.

Using colour matching tools with office applications
Your Fiery user software includes two RGB colour reference pages, a Microsoft Word 
file and a Microsoft PowerPoint file. You can print these files using different CRDs to 
see how the colours appear when printed to the Fiery. For best results, print the colour 
reference page using the same print options you plan to use for your final document. 
Select the colours you want to use from the printed version of the RGB colour 
reference page and use those colours in your document.

Working with office applications
Before printing from these applications, make sure the appropriate printer driver and 
the Fiery PPD are installed on your computer, as described in the User Software 
Installation Guide.

RGB Colour Reference (Microsoft PowerPoint)
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Defining colour
Office applications use the RGB colour model. The only way to use CMYK or 
PANTONE colours is to define them in EPS format files with an illustration or page 
layout application, and then place these files in Microsoft Office documents. Colours 
in EPS files are preserved until they reach the Fiery (assuming no PostScript Colour 
Management information was included).

Office applications use low resolution to display EPS files, but the EPS images are 
printed at full resolution. In general, use EPS files only when RGB colours are 
impractical in your specific workflow. EPS files are useful when using large or complex 
images that must be printed at full resolution or exceed the memory allocation of some 
Microsoft Office applications.

Working with imported files
Your application may allow you to import a variety of file formats. If you encounter 
printing problems when using other imported file formats such as TIFF and PICT, 

EPS files are recommended.

NOTE: If you are unable to import EPS elements, it may be necessary to perform a 
“custom install” of your Microsoft Office applications.

Even when there are no user-defined colour management options within office 
applications, colour conversions do occur when you import images or page elements 
that were not defined in RGB. To avoid such conversions with imported files, use the 
EPS file format for non-RGB artwork that is to be imported into office applications.

All RGB images placed in a document are affected by the settings you choose for the 
RGB Source and Rendering Style print options.

Mixing imported image types (Advanced colour management)

If you place multiple RGB images—mixed non-photographic and photographic—into 
an office application file, a single CRD may not optimize output for all the images. 
In this case, you may want the photographic images to bypass the CRD altogether. 
To accomplish this, open the photographic image in CMYK mode with a pixel-editing 
application, such as Photoshop, and perform colour correction. Save the image as a 
Photoshop EPS and import it into the document.
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Selecting options when printing
There are few differences among office applications with regard to Fiery printing. To 
specify print options and colour management settings, follow the instructions in the 
Colour Guide Chapter 1. To specify these options, you must use a PostScript Level 2 (or 
later) printer driver, such as an Adobe PostScript Printer Driver.

Because office applications send RGB data to the Fiery, your choice of RGB Source 
and Rendering Style settings are important. Specify the appropriate CRD for the 
desired colour effect (see the Colour Guide Chapter 1).

Output profiles
All colour data in the job is affected by the output profile on the Fiery. This profile 
may be the one designed for your device and shipped with the Fiery, or it may be a 
custom profile created at your site (see the Colour Guide Chapter 1). If necessary, print 
the Test Page to see which profile is the active default on the Fiery. 

Ensuring colour accuracy when you save a file
Take the following steps to ensure colour accuracy:

• When saving EPS files, do not include PostScript Colour Management information. 
This minimizes the risk of conflicting data and multiple colour conversions. 
PostScript Colour Management causes your CMYK and RGB colours to be 
interpreted by the Fiery as though they were supplied in the Lab colour space and, as 
a result, processed by CRDs, rather than your simulation settings.

• Include ICC colour information in files. ColorWise does not conflict with this 
information, and such data is useful for identifying the specific colour space used by 
your files.

• Do not include halftone and transfer functions.

• Turn off colour management in the printer driver.

On Windows computers, if the printer driver offers Image Colour Matching 
options, select Printer Image Colour Matching.

On Mac OS computers, set the printer driver to include no colour management 
commands at print time (see the Colour Guide Chapter 1).
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This chapter provides guidelines for using applications that have the ability to write 
their own PostScript, such as some page layout, illustration, and pixel-editing 
applications. For information about using specific applications, see “Managing Colour 
in Adobe Photoshop” on page 5-1, “Managing Colour in Page Layout Applications” 
on page 6-1, or “Managing Colour in Illustration Applications” on page 7-1. 

Working with PostScript applications
Most applications used for illustration, pixel editing, and page layout can create the 
PostScript information they send to a PostScript printer or save in PostScript files. 
Illustrator, Photoshop, PageMaker, QuarkXPress, and Macromedia FreeHand are 
all PostScript applications.

PostScript applications work with colour in many different ways. Most allow you to 
choose process colours(by entering percentages for cyan, magenta, yellow, and black), 
as well as named colours from a spot colour system,such as PANTONE. When you 
print composites, these applications send process-colour equivalents for named spot 
colours to the Fiery. In some applications, you can also choose colours using the RGB, 
HSB, HSL, or other colour models.

Generally, PostScript applications send colour information to the Fiery as CMYK data. 
An exception to this is an RGB image placed in a document, which is sent directly 
to the Fiery (unless you specify special colour management settings in the application). 
In addition, some PostScript applications that allow you to define colours in RGB or 
other colour models also send data to the Fiery in those colour spaces.

Colour controls in PostScript applications are typically designed for printing on an 
offset press, and some adjustments are required for printing to the Fiery. Displayed 
versions of colours you choose in these applications may not match C9800 output 
exactly, and named colours may not print accurately on the C9800, since these colours 
typically require custom inks.

Chapter 4:
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Using colour matching tools with PostScript applica-
tions
With PostScript applications, you can work with colours created with any of the colour 
models supported by the application. All PostScript applications support CMYK; some 
also support RGB and other colour models based on monitor display values. PostScript 
applications also allow you to choose named colours using one or more colour libraries, 
such as PANTONE (see page 4-3).

Using swatch colour matching tools
Your Fiery user software includes several colour reference pages (see page 1-4). By 
choosing colours from these reference pages, you ensure that you get the same colour 
from your C9800. For best results, calibrate the Fiery before printing the reference 
pages.

NOTE: We highly recommend that you use swatch colour matching to ensure 
predictable colour printing results with the C9800 or match your C9800 output to 
colours produced by other printers.

NOTE: Swatch colour matching does not match monitor colours to printed colours. 
For this, you must use a colour management system and calibrate your monitor.
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Using the CMYK Colour Reference
Use the CMYK Colour Reference included with your Fiery user software to see how 
various cyan, magenta, yellow, and black combinations look when printed on your 
C9800.

To print the CMYK Colour Reference, download the file to the Fiery. The printed 
pages display groups of colour patches in graduated combinations of yellow, magenta, 
and cyan, and smaller patches that include 25%, 50%, and 75% black. Refer to these 
pages to pick colours and specify process colour values in your application. For the 
location of the file on the User Software CD, see the User Software Installation Guide.

Using the PANTONE reference
Use this reference (Process Simulation of PANTONE Solid Coated Colours) included 
with your Fiery user software to help ensure predictable results with colours chosen 
from the PANTONE colour library.

The information printed by this reference depends on the Spot Colour Matching 
setting.

• Spot Colour Matching On—Prints swatches that simulate the spot colour with the 
closest equivalent available using the CMYK toners of the C9800. The equivalent 
PANTONE colour name/number is printed below each swatch.
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• Spot Colour Matching Off—Prints swatches of the CMYK equivalents of PANTONE 
colours as defined by PANTONE. (These are the same CMYK values defined in 
applications that include PANTONE libraries.) The CMYK values used to produce 
the colour, as well as the PANTONE colour name/number, are printed below 
each swatch.

To print the reference, download the file to the Fiery. For the location of the file on the 
User Software CD, see the User Software Installation Guide. If the default Spot Colour 
Matching setting on the Fiery is not the setting you want to use for printing the 
PANTONE colours, download the file to the Hold queue, and then override the Spot 
Colour Matching setting using a job management utility, such as Command 
WorkStation (see the Job Management Guide).
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Defining colours
The methods and options available for defining colours depend on the type of 
PostScript application that you are using.

Colour 
model

Application 
type

Colour definition notes

CYMK

Photoshop In Photoshop you can choose colours with various colour 
models, including HSB, CIE Lab, RGB, and CMYK.

Page layout 
application

Page layout applications generally use the CMYK colour model. 
Some allow you to define colours with other colour models and 
may be able to send that data to the Fiery in those other colour 
models. Generally, however, CRDs (which affect only RGB 
data) do not affect colours defined in page layout applications.

For predictable results with CMYK colours, use the CMYK 
Colour Reference when defining colours in page layout 
applications (see “Using colour matching tools with PostScript 
applications” on page 4-2).

Illustration 
application

All illustration applications use the CMYK colour model. 
Although you may be allowed to define colours using other 
colour models, these applications generally send only CMYK 
data to the Fiery.

For predictable results with CMYK colours, use the CMYK 
Colour Reference pages when defining colours (see “Using 
colour matching tools with PostScript applications” on 
page 4-2).

Different versions of Illustrator support colour models slightly 
differently (see “Note about colour models in Adobe Illustrator” 
on page 7-1).
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RGB

Photoshop Choose colours in Photoshop with various colour models, 
including HSB, CIE Lab, RGB, and CMYK. 

Page layout 
application

If the application allows you to define colours in RGB, 
determine whether it converts the RGB data to CMYK before 
sending it to the Fiery. If it does, this will determine which 
ColorWise print options affect your job.

For example, if the application converts RGB black (defined in 
the document as R0%, G0%, B0%) to four-colour CMYK 
black when it sends the job to the Fiery, the option you select 
for the Pure Black Text/Graphics print option has no effect 
when you print the job.

Illustration 
application

If you define colours in RGB and print directly from the 
application, the application converts the RGB data to CMYK 
before sending it to the Fiery. This conversion by the 
application determines which ColorWise print options affect 
your job.

For example, if the application converts RGB black (defined in 
the document as R0%, G0%, B0%) to four-colour CMYK 
black when it sends the job to the Fiery, the option you select 
for the Pure Black Text/Graphics print option has no effect 
when you print the job.

Spot 
Colours

Photoshop Choose named colours from the PANTONE colour library (see 
“Using the PANTONE reference” on page 4-3). For best results, 
use the colour definition methods described in “Using swatch 
colour matching tools” on page 4-2.

Page layout 
application

Illustration 
application

Colour 
model

Application 
type

Colour definition notes
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Working with imported images 
You can import images into documents created in illustration applications (such as 
Illustrator) and page layout applications (such as QuarkXPress). The recommended 
formats for images imported into page layout documents are EPS (or EPSF) and 
TIFF. If you encounter a problem using a TIFF format image, use the EPS file format. 
Support for importing other file formats may be provided by individual applications.

All RGB images placed in a document are affected by the RGB Source and 
Rendering Style settings. The ColorWise colour management system applies the 
specified RGB Source setting to all RGB data and then uses the specified Rendering 
Style (CRD) to perform a colour conversion. An exception to this occurs if you assign 
ICC profiles to RGB images using the application’s colour management tools (see the 
following section). In this case, the application performs the colour conversion of the 
image and sends CMYK data to the Fiery.

NOTE: To take advantage of RGB Source and Rendering Style settings for images 
imported into QuarkXPress, save images in the EPS format or use the Quark 
PrintRGB XTension, which outputs RGB TIFF image files without converting 
them to CMYK.

Mixing image types (Advanced colour management)

If you place multiple RGB images—mixed non-photographic and photographic—into 
a file, a single CRD may not optimize output for all the images. In this case, you may 
want the photographic images to bypass the CRD altogether. To accomplish this, 
separate the image to CMYK data with a pixel-editing application, such as Photoshop, 
and perform colour correction. Save the file as EPS or TIFF format and import it into 
the document.

If your application supports this feature, you can save the RGB image in TIFF 
format and assign it an ICC profile and rendering intent when you import it into 
the document.
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Using CMYK simulations 
You can specify a CMYK Simulation profile and a CMYK simulation method for a job 
using the CMYK Simulation Profile and CMYK Simulation Method print options 
(see the Colour Guide Chapter 1). The CMYK Simulation setting affects all CMYK 
colour data sent by the page layout or illustration application. It can also affect RGB 
data sent to a page layout application if RGB Separation is set to Simulation.

• If the document contains CMYK graphics that were separated for an offset press 
standard, apply the corresponding CMYK Simulation setting. For example, for 
graphics separated for SWOP, choose SWOP as the CMYK Simulation setting.

If you print separations to the Fiery and choose to use the Combine Separations 
feature in conjunction with Full Simulation, the result may not match that of the 
same page printed as composite.

• If the document contains CMYK graphics that were separated according to the 
colour characteristics of a custom ICC profile (not a press standard profile), specify 
the corresponding profile as the CMYK Simulation Profile setting on the Fiery.

For more information on downloading CMYK Simulation profiles to the Fiery with 
ColorWise Pro Tools, see the Colour Guide Chapter 3.

Using application-defined halftone screens
If your site has installed the Fiery Graphic Arts Package (not available for all Fiery 
models), you can define halftone screens from several PostScript applications and use 
them when printing. The results vary depending on the application.

To define a halftone screen, use the application to adjust the Frequency and Angle 
values of the halftone screen. For applications that use the Fiery default (InDesign, 
FreeHand, QuarkXPress, and Illustrator 10), the ink dots are round; for applications 
that define their own shape and do not use the Fiery default (PageMaker, Photoshop, 
and Illustrator 9),the halftone dots may be a different shape. When you print the job, 
choose Application Defined for the Halftone Screen print option.
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The Frequency and Angle settings in the Application Defined halftone screen are used 
regardless of whether the setting for Combine Separations is set to On or Off. For 
special instructions for printing separations with Photoshop, see “Selecting options 
when printing” on page 5-8,

NOTE: In general, using halftone screens is not recommended because the print output 
will have visible dots of toner rather than smooth blends. Use halftone screens only 
when necessary to achieve a specific style of print output.

Ensuring colour accuracy when you save a file
You can take the following steps to ensure colour accuracy:

• When saving EPS files, do not include PostScript Colour Management information. 
This minimizes the risk of conflicting data and multiple colour conversions. 
PostScript Colour Management causes your CMYK and RGB colours to be 
interpreted by the Fiery as though they were supplied in the Lab colour space and, as 
a result, processed by CRDs, rather than your simulation settings.

• Include ICC colour information in files. ColorWise does not conflict with this 
information, and such data is useful for identifying the specific colour space used by 
your files.

• Do not include halftone and transfer functions.

• Turn off colour management in the printer driver.

On Windows computers, if the printer driver offers Image Colour Matching 
options, select Printer Image Colour Matching.

On Mac OS computers, set the printer driver to include no colour management 
commands at print time (see the Colour Guide Chapter 1).
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This chapter covers features of Adobe Photoshop versions 7.x and 6.x for Windows 
and Mac OS. The illustrations show Mac OS dialog boxes, but the information and 
instructions apply equally to the Windows version of Photoshop.

Because Photoshop uses a sophisticated colour management system, you should 
perform some colour management tasks before you use Photoshop.

Specifying colour settings
The following sections outline the recommended colour settings for Photoshop in a 
Fiery workflow. These colour settings include:

Working Spaces—Default colour spaces to use when working with RGB and CMYK 
documents. ICC colour profiles describe the gamut and colour characteristics of these 
working spaces.

Colour Management Policies—Instructions that tell Photoshop what to do when it 
encounters colour data from a colour space other than the specified working space.

Configuring Photoshop colour settings 
Photoshop uses a sophisticated colour management system that handles document 
colours for a variety of colour-managed workflows. By customizing colour settings, you 
specify the amount of colour management you want to use while working in 
Photoshop.

TO SPECIFY COLOUR SETTINGS FOR PHOTOSHOP

1. Choose Colour Settings from the Edit menu.

The Colour Settings dialog box appears.

2. Select Advanced Mode.

Chapter 5:
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In Advanced Mode, a more extensive list of options is displayed.

3. Choose the desired working space profile for each colour mode in the 
Working Spaces area.

A working space specifies the colour profile for documents that have no colour profile 
associations or for documents that are newly created. It also defines colour space of a 
document converted to RGB, CMYK, or Grayscale colour modes, and for spot colours 
in a document.
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Choose an appropriate ICC profile to embed when saving a file for each colour space. 
Use the following guidelines for specifying working spaces:

• For RGB, choose the profile for the default RGB colour space used by the Fiery. In 
most cases, this is EFIRGB. (For information about installing the EFIRGB profile, 
see the User Software Installation Guide.) Consider sRGB if you usually view images 
on a generic PC monitor or rely on a Windows operating system to manage colour 
on your monitor. If you choose sRGB as a working space, you must print with the 
ColorWise RGB Source option set to sRGB. New RGB documents you create in 
Photoshop will use this working space.

NOTE: EFIRGB is set as the default RGB source colour space on the Fiery. 
No matter what RGB space you select, make sure it is available on the Fiery. For 
more information on downloading RGB source profiles to the Fiery, see the 
Colour Guide Chapter 3.

• For CMYK, choose a profile that describes your target press (such as SWOP) if you 
are a prepress user. If you are an office user printing final output, choose an output 
profile that describes the C9800. To use a device-specific output profile, you must 
first upload the profile from the Fiery to your computer (see the Colour Guide 
Chapter 3). New CMYK documents you create in Photoshop will use the specified 
working space.

• For guidelines on specifying Gray and Spot working spaces, see your Photoshop 
documentation.

4. In the Colour Management Policies area, choose policies for handling documents 
without embedded profiles or with embedded profiles that differ from the working 
space.

Unless you are an advanced colour user, choose Off from the RGB, CMYK, and 
Gray menus. If you specify a colour management policy and open a document in an 
environment with a different working space than the one in which it was created, you 
may encounter problems. The profile embedded in a document may be overwritten if 
it differs from the specified working space (although the numeric colour values in the 
document are preserved).
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5. If you do not choose Off for the Colour Management Policies, select Profile 
Mismatches: Ask When Opening, Ask When Pasting, and Missing Profiles: Ask When 
Opening.

This option displays an alert message that allows you to override the specified policy 
behavior (Off ) when opening documents or importing colour data.

This is recommended so that you will be notified before any application colour 
management is applied.

6. In the Conversion Options area, specify settings for converting between colour spaces.

Choose Adobe (ACE) from the Engine menu to use the built-in colour management 
engine for Photoshop.

Choose a rendering intent from the Intent menu that will optimize the colour quality 
of the conversion. For guidelines on choosing the rendering intent, see your Photoshop 
documentation.

Select Use Black Point Compensation and Use Dither (8-bit/channel images) to 
optimize the quality of colour conversions.

7. Clear the Desaturate Monitor Colours By and Blend RGB Colours Using Gamma options 
in the Advanced Controls area.

Clearing these options helps ensure a match between your monitor display and the 
printed output.

8. Click Save to save the current group of colour settings.

The Save dialog box appears.

9. Name the settings file, accept the default saved location, and click Save.

You can switch to your saved settings at any time by choosing the group name from the 
Settings menu at the top of the Colour Settings dialog box.
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Saving files from Photoshop
Before saving a file from Photoshop, perform any necessary rotating, cropping, and 
resizing. This speeds processing when printing from the application in which the 
image is placed.

When saving a document from Photoshop 6.x, you have the option to embed a colour 
profile in the document. We recommend that you disable this option if you are 
sending the document to the Fiery.

Choosing a file format
We recommend that you use EPS or TIFF file formats to save RGB images that will be 
imported into other documents and printed to the Fiery. You can import EPS and 
TIFF files into virtually all page layout applications.

NOTE: Although TIFF files generally display better when imported into other 
applications, their colour and resolution characteristics may be altered by the 
application into which they are imported. EPS files are not modified by the application 
into which they are imported.

NOTE: In the following procedures, only Photoshop 7.x (Mac OS version) dialog boxes 
are shown. When applicable, differences between versions 7.x and 6.x, and the 
Windows and Mac OS versions of Photoshop are noted.
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TO SAVE A DOCUMENT FROM PHOTOSHOP

1. Choose Save As from the File menu.

The Save As dialog box appears.

2. Specify settings in the Save As dialog box.

• Specify a name, file format, and location for the document.

• Clear the Embed Colour Profile option (Mac OS) or ICC Profile option 
(Windows).
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3. Click Save.

If you chose Photoshop EPS as the format, the EPS Options dialog box appears.

4. Specify EPS options and click OK.

• Choose a TIFF preview option. A TIFF preview is compatible with both Windows 
and Mac OS computers.

• Do not select the PostScript Colour Management option. For more information 
about PostScript Colour Management, see the following section.

• Do not select Include Transfer Function or Include Halftone Screen.

NOTE: If you choose JPEG encoding, save a backup of the original image saved with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see 
unexpected results in the printed output of a JPEG file, revert to a binary version.

If you experience problems printing the document in which you placed the image, 
substitute an ASCII version of the same image and reprint the document. Binary 
encoding is much more compact than ASCII encoding, but occasionally causes 
printing problems with some system configurations.



55-8 Managing Colour in Adobe Photoshop
Selecting options when printing
You can print RGB or CMYK images from Photoshop.

• When you print an RGB image, you choose whether the conversion to CMYK is 
performed by the Fiery (using a CRD), PostScript (using PostScript Colour 
Management), or Photoshop built-in colour management.

• When you print a CMYK graphic, you can print composites or colour separations.

NOTE: Make sure that the Fiery Combine Separations print option is set to Off. To 
print separations, use the Separation option in the Adobe Photoshop pane of the print 
dialog box. For instructions, see your Photoshop documentation.

TO PRINT IMAGES FROM PHOTOSHOP 7.X 

1. Choose Print with Preview from the File menu.

The Print dialog box appears.

2. Select Show More Options.

Photoshop 7.x
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3. Select Output.

4. Choose an Encoding method. 

NOTE: If you choose JPEG encoding, save a backup of the original image with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see 
unexpected results in the printed output of a JPEG file, revert to the binary version.

5. Select Colour Management.

6. Choose Same as Source from the Profile menu to specify the colour space for printing 
the image.

Any other setting causes Photoshop to convert image data to that colour space before 
sending it to the Fiery.

7. Click Print.

Photoshop 7.x
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TO PRINT IMAGES FROM PHOTOSHOP 6.X

1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Fiery from the Printer menu, and then choose Adobe Photoshop from the 
pop-up menu.

3. Choose an Encoding method. 

NOTE: If you choose JPEG encoding, save a backup of the original image with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see 
unexpected results in the printed output of a JPEG file, revert to the binary version.

4. Choose Same as Source from the Profile menu to specify the colour space for printing 
the image.

Any other setting causes Photoshop to convert image data to that colour space before 
sending it to the Fiery.

5. Click Print.

Photoshop 6.x
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Advanced tips for using PostScript colour management
Use the following information to implement alternative, more complex, colour 
workflows with Photoshop.

NOTE: To use PostScript colour management with Photoshop 6.x, choose PostScript 
Colour Management from the Profile menu in the Photoshop pane of the printer 
driver.

Saving EPS documents with PostScript Colour Management

Selecting the PostScript Colour Management option when saving either a CMYK or 
RGB EPS file prompts Photoshop to embed PostScript colour information—which is 
independent of ICC profiles—in the resulting document. This information is 
intended for PostScript devices like the Fiery.

Printing RGB EPS files saved with PostScript Colour Management

When you print an RGB EPS file that contains an embedded profile to the Fiery, you 
can use the working space information from the embedded RGB profile as an RGB 
source definition for Fiery CRDs. To use this source colour space information from the 
embedded profile with Fiery CRDs, choose None as the ColorWise RGB Source when 
you print. This applies when you print directly from Photoshop, or when the same 
RGB EPS file is output from another application.

To override the embedded profile in an EPS file using an RGB Source definition made 
available by the Fiery, choose anything except None as the Fiery RGB Source Profile.

Printing RGB images with Photoshop PostScript Colour Management 

If you select an RGB colour space and decide to use PostScript Colour Management, 
Photoshop sends RGB data to the Fiery along with PostScript colour information 
defining this RGB colour space. When you select PostScript Colour Management, a 
CRD is used to perform colour conversions to CMYK.

NOTE: The included RGB source colour space information is overridden by the 
ColorWise RGB Source option unless it is set to None. The ColorWise Rendering 
Style option specified will take effect if the ColorWise RGB Source Profile option is set 
to None.



55-12 Managing Colour in Adobe Photoshop
For fastest print times, choose JPEG encoding, but inspect printed output carefully 
for unwanted artifacts that may appear as a result of JPEG compression. If you 
see unexpected results in the printed output, reprint the job using Binary or 
ASCII encoding.

Printing CMYK EPS files saved with PostScript Colour Management

If you select the Photoshop PostScript Colour Management option when you save a 
CMYK EPS image, Photoshop embeds PostScript colour information that defines the 
CMYK source colour space of the image. When you print a CMYK EPS file that 
contains PostScript colour information to the Fiery, CRDs are used instead of 
ColorWise CMYK Simulation and Simulation Method settings. Choose the 
appropriate setting for the Rendering Style option.

Printing CMYK graphics with Photoshop PostScript Colour Management

If you select a CMYK colour space and decide to use PostScript Colour Management, 
Photoshop sends CMYK data to the Fiery along with PostScript colour information 
defining this CMYK colour space. When you select PostScript Colour Management, a 
CRD is used to perform colour conversions to the CMYK colour space of the Fiery.

The destination colour space for the CRDs is determined by the RGB Separation print 
option. If RGB Separation is set to Simulation, the CMYK graphic is printed 
according to all specified CMYK Simulation Profile and CMYK Simulation Method 
settings. If RGB Separation is set to Output, the CMYK graphic is converted to the 
CMYK colour space of the selected output profile.

Setting the Fiery print option Spot Colour Matching to On has an effect only if you 
use the Photoshop Multi-Channel feature to define spot channels and then save the 
image in EPS format and open it in another application. For information see your 
Photoshop documentation.
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Photoshop converts spot colours to CMYK values when you work in CMYK mode.

• If the graphic was separated for an offset press standard, apply the corresponding 
CMYK Simulation setting. For example, if the graphic is separated for SWOP, 
choose SWOP as the CMYK Simulation setting.

• If Photoshop is configured for a custom separation using a ICC profile, choose the 
corresponding profile for the ColorWise CMYK Simulation option.

The previous custom simulation setting requires that the same profile used for 
separation in Photoshop also resides on the Fiery. For more information 
about downloading CMYK Simulation profiles to the Fiery with ColorWise Pro Tools, 
see the Colour Guide Chapter 3.
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This chapter provides instructions for printing colour documents from Adobe 
InDesign, Adobe PageMaker, and QuarkXPress.

Before printing from these applications, make sure the appropriate printer driver 
and the Fiery PostScript printer description file (PPD) are installed on your computer, 
as described in the User Software Installation Guide.

Adobe InDesign 2.0.1 and 1.5.2
The following sections outline the recommended settings for using Adobe InDesign 
with a Fiery.

InDesign colour settings
When using ColorWise colour management, turn off the InDesign colour 
management features.

Chapter 6:
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TO DISABLE INDESIGN 2.0.1 COLOUR MANAGEMENT

1. Choose Colour Settings > Document Colour Settings from the Edit menu.

2. Clear the Enable Colour Management option and click OK.
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TO DISABLE INDESIGN 1.52 COLOUR MANAGEMENT

1. Choose Colour Settings > Document Colour Settings from the Edit menu.

2. Clear the Enable Colour Management option and click OK.

Importing images
All RGB images placed in a document, except for RGB TIFF images, are affected by 
your RGB Source and Rendering Style settings. For best results with placed images, use 
the instructions in “Working with imported images” on page 4-7.

NOTE: InDesign converts placed RGB TIFF images to CMYK.

Disable InDesign colour management when placing images in a document.

TO DISABLE INDESIGN 2.0.1 COLOUR MANAGEMENT WHEN IMPORTING 
IMAGES

1. Choose Place from the File menu.

The Place dialog box appears.

2. Select the Show Import Options option.

3. Select the file you want to import and click Open.
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4. Choose Colour Settings from the option menu. Make sure the Enable Colour 
Management option is cleared, and click OK.

TO DISABLE INDESIGN 1.5.2 COLOUR MANAGEMENT WHEN IMPORTING 
IMAGES

1. Choose Place from the File menu.

The Place dialog box appears.

2. Select the Show Import Options option.

3. Select the file you want to import and click Place.

4. Choose Colour Settings from the option menu. Make sure the Enable Colour 
Management option is cleared, and click OK.
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Selecting options when printing
You can use the standard Fiery printer driver interface to select print options from 
InDesign.

TO SET PRINT OPTIONS FROM THE WINDOWS VERSION OF INDESIGN 2.0.1

1. Choose Print from the File menu.

2. Choose the Fiery from the Printer menu.

3. Click Setup.

The Windows Print dialog box appears.

4. Click Properties.



66-6 Managing Colour in Page Layout Applications
5. Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Fiery appears.

6. Choose the desired print options.

For information on setting ColorWise print options, see the Colour Guide Chapter 1.

7. Click Print.

TO SET PRINT OPTIONS FROM THE MAC OS VERSION OF INDESIGN 2.0.1

1. Choose Print from the File menu.

2. Choose the Fiery from the Printer menu.
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3. Click Printer.

The AdobePS Print dialog box appears.

4. Choose Printer Specific Options.

The Fiery print options appear.

5. Select the desired options.

For information on setting ColorWise print options, see the Colour Guide Chapter 1.

6. Click Print.
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TO SET PRINT OPTIONS FROM THE WINDOWS VERSION OF INDESIGN 1.5.2

1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Fiery from the Name menu.

3. Click Properties.

4. Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Fiery appears.

5. Choose the desired print options.

For information on setting ColorWise print options, see the Colour Guide Chapter 1.
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TO SET PRINT OPTIONS FROM THE MAC OS VERSION OF INDESIGN 1.5.2

1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Fiery from the Printer menu.

3. Choose Printer Specific Options.

The Fiery print options appear.

4. Select the desired options.

For information on setting ColorWise print options, see the Colour Guide Chapter 1.
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Adobe PageMaker 7.x and 6.5 for Mac OS and Windows
The Mac OS and Windows versions of PageMaker 7.x and 6.5 are essentially the same. 
The illustrations in this section show only the Windows version, except where 
differences exist between the two versions.

Windows version requirement
To use the Windows version of PageMaker 6.5, make sure a copy of the Fiery PPD file 
is in the following folders:

• PM65\RSRC\USENGLSH\PPD4

• Windows\System

For information about installing this file, see your PageMaker documentation.

PageMaker colour settings
We recommend that you use ColorWise colour management rather than the CMS 
options built into Adobe PageMaker.

NOTE: Do not use both systems for the same print job.

TO DISABLE PAGEMAKER COLOUR MANAGEMENT 

1. Choose Preferences > General from the File menu.

2. Click CMS Setup.

3. Choose Off from the Colour Management menu.

4. Click OK, and then click OK again to close the dialog boxes. 

TO DISABLE COLOUR MANAGEMENT FOR A BITMAPPED IMAGE

1. Select the bitmapped image in the document.

2. Choose Image > CMS Source from the Element menu.

3. Choose None from the This Item Uses menu and click OK.
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Importing images
All RGB images placed in a document are affected by your RGB Source and Rendering 
Style settings. For best results with placed images, use the instructions in “Working 
with imported images” on page 4-7.

Selecting options when printing
All print settings are specified from the various Print dialog boxes in PageMaker 7.x 
or 6.5.

NOTE: The Print dialog box for PageMaker is different than the Print dialog box for 
other applications that print to the Fiery. Follow the instructions in this section rather 
than the print instructions in the Colour Guide.

TO SET PRINT OPTIONS WHEN PRINTING FROM PAGEMAKER

1. Choose the Fiery printer description from the PPD menu in the Print Document dialog 
box.

2. Click Options.

3. Choose Normal from the “Send image data” menu in the Print Options dialog box and 
click Features.

To ensure that TIFF images print at their full resolution, do not choose the Optimized 
Subsampling default from the “Send image data” menu.

Choose the Fiery PPD

Click Options
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4. If a document contains RGB placed images or colours defined in RGB that will not be 
separated to process colours, choose RGB Source and Rendering Style settings in the 
Print Features dialog box.

If the document contains PANTONE colours, choose the appropriate Spot Colour 
Matching setting. 

5. Click Print from any of the PageMaker dialog boxes to send the job to the Fiery. 

Using optional Colour Management from PageMaker
If you have additional colour management requirements not offered by ColorWise, 
such as managing colour on devices not controlled by the Fiery, consider using the 
PageMaker colour management features. For more information, see your PageMaker 
documentation.

QuarkXPress 5.x and 4.x for Mac OS

Importing images
With the exception of RGB images that are saved in EPS format or use Quark 
PrintRGB XTension, QuarkXPress converts all RGB data into CMYK, even when 
Quark CMS XTension is disabled.

Only RGB images saved in EPS format are affected by RGB Source and Rendering 
Style settings. For best results with placed images, follow the instructions in “Working 
with imported images” on page 4-7.
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Selecting options when printing
The following procedure provides instructions on printing files to the Fiery.

TO SET PRINT OPTIONS IN QUARKXPRESS 5.X OR 4.X

1. Choose the Fiery printer description name from the Printer Description menu in the 
Print dialog box.

2. If the document contains PANTONE colours, choose the appropriate Spot Colour 
Matching setting.

For instructions on specifying print options, see the Colour Guide Chapter 1.

Optional Colour Management from QuarkXPress
If you have additional colour management requirements not offered by ColorWise, 
such as managing colour on devices not controlled by the Fiery, you may want to 
consider using the QuarkXPress colour management features. For more information, 
see your QuarkXPress documentation.

For QuarkXPress 4.02, consider using Quark CMS XTension. These features allow 
advanced users to control RGB to CMYK colour conversions. If you plan to use 
these features, make sure that Quark CMS XTension is installed before starting 
QuarkXPress. If it is not installed, use the Quark XTensions Manager to install it. 
For instructions, see your QuarkXPress documentation.

Choose the Fiery

Choose an output paper size

Click to specify printer settings

Mac OS
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NOTE: Quark CMS converts RGB TIFF, JPEG, and PICT images to CMYK before 
sending colour data to the Fiery. RGB Source and Rendering Style settings have no 
effect on this data unless you use Quark PrintRGB XTension, which outputs RGB 
TIFF image files without converting them to CMYK.

QuarkXPress 3.32 for Mac OS and Windows
Before starting QuarkXPress 3.32, make sure the EfiColor XTension is not loaded in 
the XTensions folder. EFICOLOR profiles are not currently provided with Fiery 
products. Without the correct EFICOLOR profile, the EfiColor XTension cannot 
perform colour conversions on placed images.

Windows version requirement
For the Windows version of QuarkXPress, make sure a copy of the Fiery PPD file is in 
the \XPRESS\PDF folder.

Importing images
All RGB images placed in a document are affected by your RGB Source and Rendering 
Style settings. For best results with placed images, follow the instructions in “Working 
with imported images” on page 4-7. 

Selecting options when printing
The following procedure provides instructions on printing files to the Fiery.

TO SELECT PRINT OPTIONS IN QUARKXPRESS 3.3

1. Choose the Fiery printer description from the Printer Type menu in the Page Setup 
(Mac OS) or Printer Setup (Windows) dialog box.
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2. If a document contains RGB-placed images or RGB colours that QuarkXPress will 
print without converting to CMYK, choose RGB Source and Rendering Style settings. 

If the document contains PANTONE colours, choose the appropriate Spot Colour 
Matching setting. 

For instructions on specifying print options, see the Colour Guide Chapter 1.

Choose an output paper size 

Choose the Fiery

Mac OS

Choose Binary

Choose the Fiery

Windows

Choose output
paper size

Choose Binary
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You can print directly from an illustration application or use it to create and save files 
that will be imported into a page layout document. To print from an illustration 
application, use the printer driver and print settings recommended in the Colour Guide 
Chapter 1. As a general rule, use the EPS file format when saving files with an 
illustration application. When an EPS file is imported into another application, the 
colour information in the imported image will not be changed by the application into 
which it is imported.

Before printing from illustration applications, make sure the appropriate PostScript 
printer driver and the Fiery PPD are installed on your computer, as described in the 
User Software Installation Guide. This chapter provides instructions for using 
Adobe Illustrator, Macromedia FreeHand, and CorelDRAW for Windows and 
Mac OS.

NOTE: This manual provides instructions for printing composites only. 
For instructions on printing colour separations, see the documentation for 
your application.

Adobe Illustrator for Windows and Mac OS 
The following sections provide guidelines for working with Adobe Illustrator versions 
10.x and 9.x.

Note about colour models in Adobe Illustrator
In Illustrator, you can set the Document Colour Mode to either RGB Colour or 
CMYK colour. All elements in that file are created in that colour model. When you 
print the file, the data is sent to the Fiery in the colour model that you specified.

Illustrator colour settings
Illustrator uses a sophisticated colour management system that can handle both RGB 
and CMYK colours for a variety of colour-managed workflows. By customizing colour 
settings, you specify the amount of colour management you want to use while working 
in Illustrator. These colour settings include:

Chapter 7:
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Working spaces—Default colour spaces to use when working with RGB and CMYK 
documents. ICC colour profiles describe the gamut and colour characteristics of these 
working spaces.

Colour management policies—Instructions that tell Illustrator what to do when it 
encounters colour data from a colour space other than the specified working space.

Specifying print options
The following procedure outlines the recommended colour settings for Illustrator in a 
Fiery workflow.

TO SPECIFY COLOUR SETTINGS

1. Choose Colour Settings from the Edit menu.

The Colour Settings dialog box appears.

2. Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.
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3. Choose the desired working space profile for each mode in the Working Spaces area.

Use the following guidelines for specifying working spaces:

• For RGB, choose EFIRGB. This profile represents the default RGB colour space 
used by the Fiery. New RGB documents you create in Illustrator will use this 
working space.

• For CMYK, choose a profile that describes your target press (such as SWOP) if you 
are a prepress user. If you are an office user printing final output, choose an output 
profile that describes the C9800. To use a device-specific output profile, upload the 
profile from the Fiery to your computer (see the Colour Guide Chapter 3). New 
CMYK documents you create in Illustrator will use the specified working space.

4. Choose policies for handling documents without embedded profiles or with embedded 
profiles that differ from the working space in the Colour Management Policies area.

Choose Off from the RGB and CMYK menus. This option discards the original 
profile embedded in a document if it differs from the specified working space.

In the Profile Mismatches area, select the Ask When Opening option. This option 
displays an alert message that allows you to override the specified policy behavior (Off ) 
when opening documents or importing colour data.

5. Choose settings for converting between colour spaces in the Conversion Options area.

Choose Adobe (ACE) from the Engine menu to use the built-in colour management 
engine for Illustrator.

Choose a rendering intent from the Intent menu that will optimize the colour quality 
of the conversion. For guidelines on choosing the rendering intent, see your Illustrator 
documentation.

Select the Use Black Point Compensation option to optimize the quality of 
colour conversions.

6. Click Save to save the current group of colour settings.

The Save dialog box appears.

7. Name the settings file, accept the default saved location, and click Save.

You can switch to your saved settings at any time by choosing the group name from the 
Settings menu at the top of the Colour Settings dialog box.
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Saving files for importing into other documents
When saving files in Illustrator for importing into other types of documents, use the 
EPS file format. Illustrator can save colour information in both RGB and CMYK. 
The ColorWise RGB Source and Rendering Style settings affect colour output of RGB 
artwork saved in Illustrator EPS and imported into other kinds of documents (even 
when both RGB and CMYK artwork exists in the same file). In the case of Illustrator 
files imported into Photoshop, however, vector data from the Illustrator file is 
rasterized into bitmaps in Photoshop, and the final colour space of the bitmap data is 
determined by the colour mode you set in Photoshop.

Specifying print options
The following procedure explains how to set print options when printing a document 
from Illustrator to the Fiery.

TO SET PRINT OPTIONS IN ILLUSTRATOR

1. Choose Print from the File menu in Illustrator.

The Print dialog box appears.

2. For the Windows version of Illustrator, specify appropriate print options.

• Choose the Fiery device from the Name menu.

• Choose Composite from the Output menu.

• Choose Level 3 from the PostScript menu. If you encounter problems, you can also 
use Level 2.
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Illustrator 10.x for Windows

Choose Composite

Click Properties
to set print options

Select the device name
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3. For the Mac OS version of Illustrator, specify appropriate print options.

• Choose the Fiery device from the Printer menu.

• Choose Adobe Illustrator from the option menu below the Printer menu.

• Choose Composite from the Output menu.

• Choose Level 3 from the PostScript menu. If you encounter problems, you 
can also use Level 2.

Illustrator 8.x and 9.x for Windows

Choose Composite

Choose PostScript Level 2 or 3

Click Properties
to set print options

Select the device name
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Choose Composite

Illustrator 10.x for Mac OS

Choose Composite

Choose PostScript
Level 3

Illustrator 8.x and 9.x for Mac OS
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4. If necessary, click Properties (Windows) or choose Printer Specific Options from the 
option menu (Mac OS) and choose RGB Source and Rendering Style settings for the 
Fiery.

You only need to specify these settings if you have a CMYK document containing 
placed RGB images, or an RGB document in Illustrator 9.x. In all other cases, colours 
remain unaffected by the settings.

5. If the document contains PANTONE-named colours, choose the appropriate Spot Colour 
Matching setting.

For instructions on setting additional ColorWise print options, see the Colour Guide 
Chapter 1.

Using Illustrator colour management
If you have additional colour management requirements not offered by ColorWise, 
such as managing colour on devices not controlled by the Fiery, you may want to 
consider using the Illustrator colour management features. For more information, see 
your Illustrator documentation.

FreeHand 10.x, 9.x, and 8.x for Windows and Mac OS
The information in this section applies to both the Windows and Mac OS versions 
of FreeHand. Only Mac OS dialog boxes are shown, but the information and 
instructions are identical for the Windows version.

Setting FreeHand colour settings
When using ColorWise colour management, turn off the FreeHand colour 
management features.
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TO DISABLE COLOUR MANAGEMENT IN FREEHAND

1. Choose Preferences from the File menu.

2. Click the Colours category in the Preferences dialog box.

3. Choose None for the type of colour management.

Defining colours
Any colours defined in FreeHand are sent to the device in CMYK—even those defined 
using other colour models. For best results, use the colour definition methods 
described on page 4-2.

You can control the conversion of RGB colours defined in FreeHand by specifying 
settings in the Preferences dialog box under the Colours category, or choosing Colour 
Management from the FreeHand menu on the Print dialog box.

Click Colors to access the color 
management settings
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Importing images
A number of file types can be imported into FreeHand, but once imported, all are 
treated as EPS images, TIFF images, or editable paths. For details, see your FreeHand 
documentation.

When you import an EPS image into a document, FreeHand inserts a link to the 
image rather than embedding the original file, resulting in a smaller file size. If the 
image is a CMYK EPS file, the colours print just as they would from the originating 
application.

NOTE: Before placing a CMYK EPS file, be sure the file was saved with Desktop 
Colour Separation (DCS) set to Off. If the file was saved with DCS activated, 
FreeHand prints composites of the image at the low resolution used for screen viewing.

All RGB images placed in a document are affected by your RGB Source and Rendering 
Style settings in the PPD. For best results with placed images, follow the instructions 
in “Working with imported images” on page 4-7.

Saving files for importing into other documents
When saving files in FreeHand for importing into other types of documents, use the 
EPS file format. FreeHand saves all colour information in CMYK. The RGB Source 
and Rendering Style print options have no effect on the colour output of RGB artwork 
saved in FreeHand and imported into other types of documents. In the case of 
FreeHand files imported into Photoshop, however, vector data from the FreeHand file 
is rasterized into bitmaps in Photoshop, and the final colour space of the bitmap data is 
determined by the colour mode you set in Photoshop.
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Selecting options when printing

TO SET OPTIONS WHEN PRINTING FROM FREEHAND

1. Select the Use PPD option in the Print dialog box.

2. Choose Normal from the Print setting menu. 

• If the Use PPD option is selected, a plus sign (+) appears in front of the 
word “Normal.”

• If the model name for your Fiery is not displayed, click the button 
labeled “…” and choose the appropriate Fiery model from the menu that appears.

3. To use ColorWise colour management features, choose Output Options from 
the File menu.

The Output Options dialog box appears.

Click to select a printer 
description
(Name appears at right)

Choose Normal
Click to access

FreeHand Print Setup

Clear option to use ColorWise 
color management
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4. Make sure the “Convert RGB to process” option is cleared.

If this option is selected, FreeHand colour management settings are used to convert 
RGB colours and RGB TIFF, PICT, and JPEG images to CMYK.

5. If a document contains placed RGB images, choose RGB Source and Rendering 
Style settings. 

With the exception of placed RGB images, these settings have no effect on colours 
printed with FreeHand. If the document contains PANTONE-named colours, choose 
the appropriate Spot Colour Matching setting when you print the document.

For information about other FreeHand print options, see your FreeHand 
documentation.

Optional colour management in FreeHand
If you have additional colour management requirements not offered by ColorWise, 
such as managing colour on devices not controlled by the Fiery, you may want to 
consider using the FreeHand colour management features. For more information, see 
your FreeHand documentation.
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CorelDRAW for Windows and Mac OS 
The following sections describe the recommended colour settings for CorelDRAW
9.x and 8.x.

Defining colours
Any colours defined in CorelDRAW 9.x for Windows or CorelDRAW 8.x for Mac OS 
are sent to the device in CMYK—even those defined using other colour models. For 
best results, use the colour definition methods described in “Using colour matching 
tools with PostScript applications” on page 4-2.

You can control the conversion of RGB colours defined in CorelDRAW by specifying 
settings in the Colour Management dialog boxes. On Windows computers, the Colour 
Management dialog boxes are located in Tools > Colour Management. On Mac OS 
computers, the Colour Management functions are located in Edit:Preferences:Global.

NOTE: If you do not want to use colour management in CorelDRAW, choose None 
from the composite printer menu under Colour Management/Profiles. Do not select 
options under Colour Management and Colour Management General.

Importing images
All RGB images placed in a document are affected by the RGB Source and Rendering 
Style settings. For best results with placed images, follow the instructions in “Working 
with imported images” on page 4-7.

Saving files for importing into other documents
When saving files in CorelDRAW for importing into other types of documents, 
use the EPS file format. CorelDRAW saves all colour information in CMYK, so RGB 
Source and Rendering Style print options have no effect on colour output of artwork 
saved with CorelDRAW and imported into other kinds of documents. In the case 
of CorelDRAW files imported into Photoshop, however, vector data from the 
CorelDRAW file is rasterized into bitmaps in Photoshop, and the final colour space 
of the bitmap data is determined by the colour mode you set in Photoshop.
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Specifying print options
The following procedure outlines how to set print options when printing from 
CorelDRAW to the Fiery.

TO SET PRINT OPTIONS IN CORELDRAW

1. On Windows computers, click the General tab, and then click Print.

2. Make sure you have selected the correct device and printer description, and select the 
Use PPD option. 

3. Click Properties to specify ColorWise print options.

4. On Mac OS computers, click Printer in the General Print dialog box to select the device 
and print options.

Click Properties to access
ColorWise print options

Print device name appears here

Printer driver/PPD name 
appears here
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To use ColorWise colour management, make sure the “Use colour profile” option on 
the Misc tab of the Print dialog box is cleared. If this option is selected, CorelDRAW 
colour management settings are used to convert RGB colours and images to CMYK.

5. If a document contains placed RGB images, choose RGB Source and Rendering Style 
settings for your device.

With the exception of placed RGB images, these settings have no effect on colours 
printed with CorelDRAW.

6. If the document contains PANTONE-named colours, choose the appropriate Spot Colour 
Matching setting.

Optional colour management in CorelDRAW
If you have additional colour management requirements not offered by ColorWise, 
such as managing colour on devices not controlled by the Fiery, consider using the 
CorelDRAW colour management features. For more information, see your 
CorelDRAW documentation.

Clear this option to use 
ColorWise Color Management
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This appendix covers concepts that are basic to printing in colour, including:

• Properties of colour

• Printing techniques

• Effective use of colour

• Raster images and vector graphics

• File optimization for processing and printing

If you are already familiar with colour theory and digital colour printing, you can skip 
to the last section (“Optimizing files for processing and printing” on page 8-15) for 
tips on optimizing files for printing.

The properties of colour
This section introduces concepts that are basic to colour theory. You will encounter 
some of these concepts (such as hue, saturation, and brightness) when you work with 
colour in applications; others provide useful background information. Colour is a 
complex topic, so consider this a starting point for experimentation and further research.

The physics of colour
The human eye can see electromagnetic radiation at wavelengths between 
400 nanometers (purplish blue) and 700 nanometers (red). This range is called the 
visible spectrum of light. We see pure spectral light as intensely saturated or pure 
colours. Sunlight at midday, which we perceive as white or neutral light, is composed 
of light from across the visible spectrum in more or less equal proportions. 
Shining sunlight through a prism separates it into its spectral components, resulting in 
the familiar rainbow of colours shown in the following figure.

Appendix 8:
Desktop 
Colour Primer
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Like the sun, most light sources we encounter in our daily environment emit a mixture 
of light wavelengths, although the particular distribution of wavelengths can vary 
considerably. Light from a tungsten light bulb, for example, contains much less blue 
light than sunlight. Tungsten light appears white to the human eye, which, up to a 
point, can adjust to the different light sources. However, colour objects appear 
different under tungsten light than they do in sunlight because of the different spectral 
makeup of the two light sources.

The mixture of light wavelengths emitted by a light source is reflected selectively by 
different objects. Different mixtures of reflected light appear as different colours. Some 
of these mixtures appear as relatively saturated colours, but most appear as grays or 
impure hues of a colour.
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CIE colour model
In the 1930s, the Commission Internationale de l’Eclairage (CIE) defined a 
standard colour space, a way of defining colours in mathematical terms, to help in 
the communication of colour information. This colour space is based on research on 
the nature of colour perception. The following CIE chromaticity diagram is a 
two-dimensional model of colour vision. The arc around the top of the horseshoe 
encompasses the pure, or spectral, colours from blue-violet to red. Although the CIE 
chromaticity diagram is not perceptually uniform—some areas of the diagram seem 
to compress colour differences relative to others—it is a good tool for illustrating some 
interesting aspects of colour vision.

By mixing any two spectral colours in different proportions, we can create all the colours 
found on the straight line drawn between them in the diagram. It is possible to create the 
same gray by mixing blue-green and red light or by mixing yellow-green and blue-violet 
light. This is possible because of a phenomenon peculiar to colour vision called 
metamerism. The eye does not distinguish individual wavelengths of light. Therefore, 
different combinations of spectral light can produce the same perceived colour.

Purple colours, which do not exist in the spectrum of pure light, are found at the 
bottom of the diagram. Purples are mixtures of red and blue light—the opposite ends 
of the spectrum. 
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Hue, saturation, and brightness
A colour can be described in terms of three varying characteristics, called the HSB 
colour model: 

• Hue—tint (the qualitative aspect of a colour—red, green, or orange)

• Saturation—the purity of the colour

• Brightness—relative position between white and black

While the CIE chromaticity diagram shown earlier conveys hue and saturation, 
a three-dimensional colour model is required to add the brightness component, as 
shown in the following figure.

Brightness

Saturation
Hue
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Many computer applications 
include dialog boxes in which 
you choose colours by 
manipulating hue, saturation, 
and brightness. For example, 
some applications use a 
colour picker that can be 
reconfigured according to 
your preference (as shown 
below).

Additive and subtractive colour systems
Colour devices used in desktop publishing and printing simulate the range of visible 
colours using a set of primary colours that are combined to create other colours. There 
are two methods for creating a range of colours from a set of primary colours. 
Computer monitors and scanners are based on the additive colour model. Printing 
technologies, including the Fiery and offset presses, are based on the subtractive colour 
model.
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Additive (RGB) colour

Colour devices that use the additive colour model create a range of colours by 
combining varying amounts of red, green, and blue light. These colours are called the 
additive primaries (shown in the following figure). White is created by adding the 
maximum amount of red, green, and blue light available. Black occurs wherever all 
three colours are absent. Grays are created by adding equal amounts of all three colour 
together. Combining varying amounts of any two of the additive primaries creates a 
third, saturated hue.

A familiar device that is based on this colour model is the computer monitor, shown in 
the following figure. Monitors have red, green, and blue phosphors that emit varying 
amounts of light to display a given colour. Scanners create digital representations of 
colours by measuring their red, green, and blue components through coloured filters.

Subtractive (CMY and CMYK) colour

The subtractive colour model is the basis for colour printing, colour photographic 
prints, and transparencies. While the additive colour model simulates the visible 
spectrum of colour by adding light of three primary hues, the subtractive colour model 
starts with a “white” or neutral light source containing light of many wavelengths. Inks, 
toners, or other colourants are used to selectively absorb (subtract) certain wavelengths 
of light that otherwise would be reflected or transmitted by the media in use.
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The subtractive primaries are cyan, magenta, and yellow; they absorb red, green, and 
blue light, respectively (as shown in the following figure). Combining any two 
subtractive primaries creates a new colour that is relatively pure or saturated. For 
example, you can make red by combining magenta and yellow, which absorb green and 
blue light, respectively. White occurs when no colourant is applied. In theory, 
combining all three subtractive primaries yields black, but due to deficiencies of cyan, 
magenta, and yellow colourants, combining these three primaries actually yields a 
muddy brown. Black colourant is added to compensate for the deficiencies of cyan, 
magenta, and yellow colourants. Consequently, colour printing uses four process 
colour: Cyan, Magenta, Yellow, and blacK (CMYK). The use of black toner produces 
rich, solid blacks and allows for improved rendering of black text.
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Understanding colour gamut
Different colour reproduction techniques have different colour capabilities, or gamuts. 
Colour transparency films have comparatively large gamuts, as do colour monitors. 
The colour gamut that can be produced using process inks or CMYK toners on paper 
is smaller. This is why some colours that can be displayed on a colour monitor, 
especially bright saturated colours, cannot be reproduced exactly by your Fiery—nor, 
for that matter, can they be reproduced on a press using process colours. Moreover, 
different printers have different gamuts—some colours your printer can produce 
cannot be reproduced on an offset press, and vice versa. The following figure illustrates 
this concept of differing gamuts.

You must account for the gamut of your printer when designing on a colour monitor. 
When printed, colours that fall outside the printer gamut are “mapped” to printable 
colours. This process, referred to as gamut mapping, takes place when colour data is 
converted or adjusted to meet the gamut requirements of a printer.

The Fiery is specially designed to perform gamut mapping at high speed with high-
quality results. It provides these colour management features automatically, using 
either built-in default settings or settings you select for a particular print job. For added 
flexibility, you can also use the Fiery colour management system in combination with 
the colour management systems on Windows and Mac OS computers.

Colour transparency film

Other print device

RGB monitor

Offset press (white)
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Printing techniques
Until recently, most colour printing was done on printing presses using one of several 
printing techniques—offset lithography, flexography, or gravure, to name a few. All 
traditional printing techniques require lengthy preparation before a press run can take 
place. Short-run colour printing, including Fiery printing, eliminates most of this 
preparation. By streamlining the process of colour printing, the Fiery makes short print 
runs economically feasible.

In contemporary offset lithographic printing, digital files from desktop computers are 
output to an imagesetter, which creates film separations. The film is used to make a 
prepress proof, which is an accurate predictor of the final print job and allows you to 
make corrections before going to press. Once the proof is approved, the printer makes 
plates from the film and runs the print job on the press.

With the Fiery, you simply print the file. The Fiery processes the PostScript 
information in the file and sends four bitmaps (one each for cyan, magenta, yellow, 
and black) to the printer. The ease of Fiery printing makes possible experimentation 
that would be too costly on a press, allowing unlimited fine-tuning of colour and 
design elements.

Halftone and continuous tone devices
Halftoning is used in offset printing to print each process colour at a different 
intensity, allowing millions of different colours to be reproduced using only the four 
process colours. Depending on the required intensity of a given colour, toner is placed 
on paper in dots of different size. The grid of dots used for each toner colour is called a 
screen. Halftone screens are aligned to unique angles designed to eliminate interference 
patterns called moiré that can arise with halftoning.

Some colour printers are commonly referred to as continuous tone (contone) devices. 
They do not use traditional halftone screen patterns and angles. Contone devices are 
capable of varying the intensity of individual dots.
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Even if your colour printing is done exclusively on the Fiery, you will encounter 
concepts from offset printing if you use high-end graphics applications. For example, 
colour controls in illustration applications, such as Adobe Illustrator, are geared toward 
specifying colour for offset printing using process and spot colours. Many applications 
allow you to specify the screening used for each printing plate.

Using colour effectively
The ability to print in colour can greatly increase the effectiveness of your message, 
whether you are printing a presentation or newsletter (short-run printing), or proofing 
an ad concept that will later be printed on a press (colour proofing). Some potential 
benefits of using colour include:

• Conveying information rapidly by using colour cues

• Making use of the emotive aspects of different colours

• Increasing impact and message retention

Colour can also be a source of distraction and discord if it is used poorly. This section 
outlines some tips and concepts to consider as you approach designing colour 
materials.

A few rules of thumb
Try some of the following strategies for creating successful colour materials:

• Use colour to aid comprehension, rather than applying colours indiscriminately. 
In colour presentations, graphs, and charts, use colour to highlight patterns and 
emphasize differences.

• Use colour sparingly. In general, fewer colours work better than many colours.

• Use red as an accent colour. Red is particularly effective when used in otherwise 
monochromatic materials.

• Consider the tastes of your target audience when choosing colours.

• Keep a file of printed colour pieces that appeal to you or strike you as effective. 
Refer to it for ideas when designing your own documents.
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Colour wheel
A colour wheel like the one in the following figure is a helpful tool for understanding 
the interrelation of colours. The colours on one side of the colour wheel, from magenta 
to yellow, appear to most people to be warm colours, while those on the other side, 
from green to blue, appear to be cool. The distance between two colours on the colour 
wheel can help predict how they will appear when seen side by side.

Colours opposite one another on the colour wheel are called complements (see 
example a in the following figure), and create a striking contrast side by side. This can 
be the basis for a bold graphical design, but it is an effect you should use with 
discretion, since it can be visually fatiguing. Other bold combinations to consider are 
split complements—a colour and the two colours adjacent to its complement (example 
b)—and triads (three colours evenly spaced on the colour wheel (example c). Colours 
adjacent to one another on the colour wheel result in subtle harmonies.
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The colour wheel simplifies colour relationships for the purpose of clarity, showing 
only saturated or pure colours. Adding the myriad variations of each hue to the palette 
(more or less saturated, darker, or lighter) creates a wealth of possibilities. Taking a pair 
of complements from the colour wheel and varying the saturation and brightness of 
one or both colours produces a very different result from the pure complements. 
Combining a light tint of a warm colour with a darker shade of its cooler complement 
often gives pleasing results. Combining a darker shade of a warm colour with a light 
tint of its cooler complement produces an unusual effect that may appeal to you.

Once you have mastered the concept of the colour wheel, you have a good framework 
for experimenting with colour combinations. Many books targeted at graphic 
designers show groups of preselected colour combinations. Some are organized by 
themes or moods, and some are based on a custom colour system, such as 
PANTONE. The more you develop a critical facility for judging colour combinations, 
the more you will be able to trust your own eye for colour. The “Bibliography” on 
page B-1 at the back of this manual includes books on design.

a cb
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Colour and text
It is not a coincidence that the overwhelming majority of text you see is printed in 
black on white paper. Text in black on white is highly legible and is not fatiguing to 
read for extended periods. For many colour materials, using black text on a white 
background and confining colour to graphic elements and headings is a good choice.

When used skillfully, colour text can add flair to documents printed on paper. 
This technique is widely used in presentations. When using colour text, avoid dazzling 
text and background combinations created from primary complements, especially red 
and cyan or red and blue; they are visually fatiguing and hard to read. Colour text is 
more legible when distinguished from its background by a difference in lightness—for 
example, dark blue text on a light beige background. In addition, using many different 
colours in a string of text makes for a confused appearance and is hard to read. 
However, using a single highlight colour is an effective way to draw the reader’s eye to 
selected words. For colour text samples, see the following figure.

When using colour text, keep in mind that small font sizes typically do not print in 
colour with the same sharpness as in black. In most applications, black text prints 
exclusively in black toner, while colour text usually prints with two or more toners. 

STOP! STOP!

Exceptio probat
regulam de rebus
non exceptis.

De gustibus 
non est 
disputandum.
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Any misregistration between the different toners on paper causes colour text to lose 
definition. You can make test prints to find the smallest point size at which colour text 
prints clearly. When using high-end graphics applications that allow you to specify 
colour as percentages of cyan, magenta, yellow, black, you can create pure cyan or pure 
magenta text that prints with the same sharpness as black text. (Pure yellow text is 
extremely hard to read on anything but a dark or complementary background.)

Raster images and vector graphics
Two broad categories of artwork can be printed from a personal computer to a colour 
printer: raster images and vector graphics.

A raster image, also referred to as a bitmap, is composed of a grid of pixels, each 
assigned a particular colour value (as shown in example a in the following figure). 
The grid, when sufficiently enlarged, resembles a mosaic made from square tiles. 
Examples of raster images include scans and images created in painting or pixel-editing 
applications, such as Photoshop and Corel Painter.

The amount of data found in a raster image depends on its resolution and bit depth. 
The resolution of a raster describes the compactness of the pixels and is specified in 
pixels per inch (ppi). The bit depth is the number of bits of information assigned to 
each pixel. Black and white raster images require only one bit of information per pixel. 
Grayscale images require 8 bits per pixel. For photographic quality colour, 24 bits of 
RGB colour information are required per pixel, yielding 256 levels of red, green, and 
blue. For CMYK images, 32 bits per pixel are required.

When printing raster artwork, the quality of the output depends on the resolution of 
the source raster. If the raster resolution is too low, individual pixels become visible in 
the printed output as small squares. This effect is sometimes called “pixelation.”

In vector graphics, picture objects are defined mathematically as lines or curves 
between points—hence the term “vector” (see example b). Picture elements can have 
solid, gradient, or patterned colour fills. Vector artwork is created in illustration and 
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drawing applications, such as Illustrator and CorelDRAW. Page layout applications, 
such as QuarkXPress, also allow you to create simple vector artwork with their drawing 
tools. PostScript fonts are vector-based, as well.

Vector artwork is resolution-independent; it can be scaled to any size and resolution 
without danger of pixels becoming visible in printed output.

Optimizing files for processing and printing
The following sections provide tips on how to create image files that produce the highest 
possible print quality while minimizing the processing time and disk space they require.

Resolution of raster images
While a 72-ppi raster image appears sharp on a monitor, the same image would likely 
appear pixelated when printed to the Fiery. Colour printers are capable of much 
greater detail than computer monitors, and require correspondingly higher resolution 
image files. However, high-resolution files can be large and, therefore, cumbersome to 
transmit over a network, process for printing, store on disk, and edit.

a b
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Beyond a certain threshold, a higher image resolution greatly increases file size while 
having a minimal effect on output quality. The optimal image resolution depends on 
the resolution of the final print device. Aim for the resolution that optimizes both file 
size and output quality.

The resolution of a raster image, along with its bit depth and physical dimensions, 
determine its file size. The following table shows the file sizes of colour raster images at 
different dimensions and resolutions.

In this table, the shaded areas indicate that 200 ppi is typically the best trade-off 
between image quality and file size. However, higher resolutions (for example, 
250 to 300 ppi) may be necessary for offset printing, when quality is of the utmost 
importance, or for images containing sharp diagonal lines.

To find the best image resolution for your purposes, make test prints of some raster 
artwork at different resolutions. Start with a high-resolution image (400 ppi) and save 
versions at progressively lower resolutions, down to 100 ppi, using a pixel-editing 
application, such as Photoshop. Always save a copy of the original high-resolution 
version, in case you must revert to it. The high-resolution data cannot be recreated 
from a lower resolution version.

File size at

Image size 100 ppi 150 ppi 200 ppi 400 ppi 600 ppi

RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK

3"x 4" 0.4/0.5 MB 0.8/1.0 MB 1.4/1.8 MB 5.5/7.3 MB 12.4/16.5 MB

5"x7" 1.0/1.3 MB 2.3/3.0 MB 4.0/5.3 MB 16.0/21.4 MB 36.1/48.1 MB

8.5"x11" 2.7/3.6 MB 6.0/8.0 MB 10.7/14.3 MB 42.8/57.1 MB 96.4/128.5 MB

11"x17" 5.4/7.1 MB 12.0/16.1 MB 21.4/28.5 MB 85.6/114.1 MB 192.7/256.9 MB
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Print the files and examine the output. You will likely begin to see a marked 
deterioration in output quality at resolutions below 200 ppi, while above 200 ppi the 
improvement may be very subtle.

Raster images prepared for offset printing may need to be at higher resolutions than 
necessary for proofing on your Fiery.

Scaling
Ideally, each raster image should be saved at the actual size, and it will be placed in the 
document at the optimal resolution for the printer. If the image resolution is correct for 
the printer, there is no quality advantage to be gained by scaling an image to a percentage 
of its actual size. If you scale a large image to a percentage of its actual size, you incur 
unnecessary file transfer time, because the image data for the entire large image is sent to 
the printer. If an image is placed multiple times at markedly different sizes in a 
document, save a separate version of the image at the correct size for each placement.

If you need to place an image at greater than 100% in a document, remember that the 
output image resolution is affected. For example, if you scale a 200 ppi image to 
200%, the image is printed at 100 ppi.

Image quality

Image resolution

100 ppi 200 ppi 300 ppi 400 ppi 500 ppi 600 ppi
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GlossaryGlossary

additive colour model
A system in which colours are produced 
by combining red, green, and blue light 
(the additive primaries). An RGB video 
monitor is based on an additive colour 
model.

additive primaries
Red, green, and blue light used in 
additive colour systems. When blended 
together in proper amounts, these 
colours of light produce white. 

artifact
A visible defect in an image, usually 
caused by limitations in the input or 
output process (hardware or software); 
a blemish or error.

banding
Visible steps between shades in a colour 
gradient.

bit depth
Amount of information used for each 
pixel in a raster image. Black and white 
images require only one bit per pixel. 
Grayscale images with 256 shades of gray 
require 8 bits (or 1 byte) per pixel. 
Photographic quality colour images can 
require 24 bits per pixel (RGB images) 
or 32 bits per pixel (CMYK images).

bitmap (or raster)
An image comprised of small squares 
arranged in a grid. Each square in the 
grid is a pixel. The number of pixels per 
inch defines the resolution of a bitmap.

blasting
An undesirable effect that occurs when 
excess amounts of toner, possibly 
combined with certain types of paper 
stock, cause objects in an image to 
spread beyond the boundaries defined 
in the file.

BMP
A graphics file format established by 
Microsoft; native to the Windows 
operating system.

calibration
The process of ensuring that a device 
behaves consistently with respect to a set 
of specifications.

calibration target (or calibration set)
A set of measurements that describe the 
expected density response of a printing 
device. Calibration targets are associated 
with the output profile of the device.

CMS
See colour management system.
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CMYK
A subtractive colour model that uses 
cyan, magenta, yellow, and black, or 
process colours, used in colour printing; 
a colour model used in the printing of 
colours in four-colour process printing.

colour channel
A single-colour image that can be edited 
separately from the other colour 
channels comprising a colour space—for 
example, the red channel of an RGB 
image.

colour gamut
See gamut.

colour management system (CMS)
System used to match colour across 
different input, display, and output 
devices.

colour rendering dictionary
See CRD (Colour Rendering 
Dictionary).

colour separation
The process of separating a colour image 
into the colour components for 
printing—cyan, magenta, yellow, and 
black. Also used to refer to the four 
sheets of film that result from the process 
of separating a colour image.

colour space
A model for representing colour in terms 
of measurable values, such as the amount 
of red, green, and blue in an image. RGB 
and CMYK colour spaces correspond to 
colour devices—monitors and printers, 

respectively. Other colour spaces, such as 
CIE Lab, are based on mathematical 
models and are device-independent (that 
is, not based on the colour response of a 
particular device). See gamut.

colourant
An ink, dye, toner, paint, or other 
pigment that modifies the colour of 
media to which it is applied.

ColorWise
See ColorWise colour management.

ColorWise colour management
An ICC-open colour management 
solution, which is an easy-to-use system 
that addresses the needs of both casual 
and experienced colour management 
users.

composite printer
Any output device that can print directly 
in colour without first creating colour 
separations. A composite print can be 
used as an early proof of an offset 
print job.

continuous tone (contone)
Describes a photographic image that 
contains gradient tones from black to 
white (such as a 35mm transparency or a 
photograph). Continuous tones cannot 
be reproduced in that form for printing, 
but must be screened to translate the 
image into dots.

continuous tone (contone) image
An image containing fine gradations of 
tones, such as a photographic image.
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CRD (Colour Rendering Dictionary)
A feature of colour management systems 
and PostScript Level 2 and PostScript 3 
colour devices that maintains the best 
possible translation of colour from one 
colour device to another. A colour 
rendering dictionary (CRD) is used by 
the colour management system or the 
device’s PostScript interpreter when 
converting data between colour spaces. 
The Fiery includes several CRDs, each of 
which provides a different colour 
rendering style.

custom colour system
A system of named colour swatches that 
can be matched on press using spot 
colours or approximated using process 
colours. PANTONE and TruMatch are 
examples of custom colour systems.

DCS (Desktop Colour Separation)
A data file standard defined by Quark, 
Inc., to assist in making colour 
separations with desktop publishing 
systems; five files are created—four 
colour files (one each for C, M, Y, and 
K) and a composite colour preview file 
of the colour image. It allows an image-
editing application to perform colour 
separation and pass it through to final 
output with its integrity intact.

densitometer
An instrument commonly used in the 
graphic arts industry to measure density 
according to a specified standard. 

density
A measurement of the light-absorbing 
quality of a photographic or printed 
image.

desktop colour separation
See DCS.

DIC
A Japanese standard of specifications for 
separations, proofs, and colour printing. 

EPS (or EPSF)
See Encapsulated PostScript.

Encapsulated PostScript
A PostScript file format designed to be 
embedded in another PostScript stream.

Euroscale
A European standard of specifications 
for separations, proofs, and colour 
printing.

flexography
A printing technology that uses flexible 
raised-image plates. Flexography can be 
used to print on non-flat materials such 
as cans.

four-colour printer
A printing device that uses cyan, 
magenta, yellow, and black ink or toner.

gamma
A numeric value representing the 
relationship (gamma curve) between the 
input and output values of a colour 
device. If gamma equals 1, input values 
are mapped exactly to output values.
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gamut
A range of colours. A device gamut is the 
range of colours that a device, such as a 
device, can produce. An image gamut is 
the range of colours in a particular image.

gamut mapping
The conversion of colour coordinates 
from one device’s gamut to another—
usually accomplished with algorithms or 
look-up tables.

GCR
See gray component replacement.

GDI (Graphics Device Interface)
Graphics and display technology used by 
computers running Windows. GDI 
applications rely on GDI (rather than 
the PostScript language) to send text and 
pictures to devices.

GIF (Graphics Interchange Format)
A standard developed by CompuServe 
for bitmap graphics of up to 256 colours 
and used for posting photographic 
images on the Internet or intranet pages; 
rarely used for professional printing.

gradient
A smooth transition between two 
different colours or two shades of a 
colour.

Graphics Device Interface
See GDI.

Graphics Interchange Format
See GIF.

gravure
A printing technology that uses an 
etched cylinder that has been immersed 
in ink. The ink that remains in the 
etched areas is applied to the paper. 
The non-etched surfaces of the cylinder 
are non-printing areas.

gray component replacement (GCR)
A method for improving wet ink trapping 
and reducing ink costs in process colour 
printing. In shadow, midtone, and 
quarter-tone areas where all three process 
colours (C, M, Y) overprint, the gray 
components of those colours are 
reduced and replaced by black.

halftoning
A method for representing an original 
continuous tone image using a pattern of 
dots, lines, or other patterns. 

HSB
A colour model where each colour is 
represented by its hue, saturation, and 
brightness components; supported by 
most colour applications.

HSL
A colour model where each colour is 
represented by its hue, saturation, and 
lightness components.

ICC profile
An industry standard colour profile 
format developed by the International 
Colour Consortium (ICC) that describes 
the colour capabilities, including the 
gamut, of a colour device based on the 
differences between an ideal and the 
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current device. The ideal is often 
provided by the manufacturer as a colour 
reference file. ICC profiles are 
implemented on Mac OS computers in 
ColorSync and on Windows computers 
in Image Colour Matching (ICM). The 
Fiery colour management system, 
ColorWise, supports ICC profiles.

imagesetter
Raster-based film output device; a high-
resolution laser output device that writes 
bitmapped data onto photosensitive 
paper or film.

JPEG
A graphics file format defined by the 
Joint Photographic Experts Group 
committee of International Standards 
Organization (ISO); a standard for digital 
compression of still image graphic data.

metamerism
Phenomenon in which two colours 
composed of different combinations of 
light wavelengths appear identical under 
a specific light source, but may look 
different under other light sources. The 
colours are called “metamers.”

moiré
An undesirable pattern in images made 
using halftone screens. Moiré can be 
caused by the improper line frequency of 
the screens, improper screen angles, 
improper alignment of halftone screens, 
or by the combination of a halftone 
screen with patterns in the image itself.

named colour
A colour that is defined according to a 
custom colour system. For example, 
PANTONE 107 C is a named colour. 
(Also referred to as a spot colour).

office applications
Software applications commonly used 
for business purposes, including 
presentation applications, spreadsheets, 
and word processing programs.

offset lithography
Printing in which ink is transferred from 
printing plates to a rubber blanket and 
then from the blanket to paper.

output
See output profile.

output profile
A file that describes the colour 
characteristics of a printing device. 
The output profile is associated with 
a calibration target that defines the 
expected density response of the device.

phosphor
Material used in making computer 
monitors; phosphors glow and emit red, 
green, and blue light when struck by an 
electron beam, thus creating an image.

photographic rendering
A colour rendering style that preserves 
tonal relationships in images. 
Unprintable colours are mapped to 
printable colours in a way that retains 
differences in lightness, sacrificing colour 
accuracy as necessary.
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pixel
The smallest distinct element of a raster 
image. The term is a combination of the 
words “picture” and “element.”

PostScript
A device-independent page description 
language developed by Adobe, which is 
used to print and display pictures and 
text. PostScript 3 includes many 
enhancements to older versions of 
PostScript, including improved image 
quality and colour.

PPD (PostScript Printer Description 
file)
A file containing information about 
a particular PostScript print device’s 
capabilities and restrictions. The 
information in the PPD is presented 
via the printer driver.

prepress proof
A print made from a set of film 
separations or other file to simulate the 
results of printing. A prepress proof is 
the last opportunity to catch problems 
before the print job goes to press.

presentation graphics rendering
A colour rendering style that creates 
saturated colours but does not match 
printed colours precisely to displayed 
colours. It is appropriate for bright 
saturated colours used in illustrations 
and graphs.

process colours
The colours used in printing to simulate 
full-spectrum colour images: Cyan, 
Magenta, Yellow, blacK (CMYK).

profile
Systematically describes how a colour 
maps to a particular space. By 
identifying a source profile and an 
output profile, you initiate the 
appropriate workflow to maintain 
consistent colour values.

QuickDraw
Graphics and display technology built 
into Mac OS computers. QuickDraw 
applications rely on QuickDraw (rather 
than the PostScript language) to send 
text and pictures to devices.

raster image
Electronic representation of a page or 
image using a grid of points called pixels.

rendering intent
The style of colour rendering, or gamut 
mapping, designed for a particular type 
of colour job. An example of a rendering 
intent is Photographic rendering—also 
referred to as Image rendering or 
Contrast rendering—which is designed 
for photographic images.

resolution
The number of pixels per inch (ppi) in a 
bitmap image or the number of dots per 
inch (dpi) that a device can render.
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RGB
An additive colour model that makes a 
range of colours by combining red, 
green, and blue light, called the additive 
primaries. Commonly used to refer to 
the colour space, mixing system, or 
monitor in colour computer graphics.

simulation
See simulation profile.

simulation profile
The simulation profile describes the 
colour characteristics of another print 
device, such as a printing press, that you 
want the Fiery to simulate.

solid colour rendering
A colour rendering style intended for 
use when colour accuracy is crucial. 
Unprintable colours are mapped to the 
closest printable colours. Solid colour 
rendering does the best job of preserving 
the saturation of displayed colours.

source colour space
The colour environment of the 
originating source of a coloured element, 
including scanners and colour monitors. 

source profile
A file used by the colour management 
system to determine the characteristics of 
the colour values specified in a source 
digital image.

spectral light
The wavelengths of electromagnetic 
radiation emitted by a given light source 
that can be seen by the human eye. 

spectrophotometer
An instrument commonly used in the 
graphic arts industry to measure spectral 
light according to a specified standard.

spot colour
A colour printed on its own separation 
plate when separations are specified. A 
spot colour is printed using a custom ink 
for that colour, in contrast to process 
colours that are printed using combina-
tions of cyan, magenta, yellow, and black. 
(Also referred to as a named colour).

Status T
A spectral response for graphic arts 
reflection densitometers defined by 
ANSI (American National Standards 
Institute).

subtractive colour model
A system in which colour is produced by 
combining colourants such as paint, 
inks, or dyes on media such as paper, 
acetate, or transparent film. All printing 
devices use the subtractive colour model.

subtractive primaries
Cyan, magenta, and yellow colourants 
used in subtractive colour systems for 
colour printing. Combining the 
subtractive primaries produces darker 
colours. Black is added to the subtractive 
primaries to compensate for deficiencies 
of the toners or inks, and for more 
efficient black printing.

substrate
In printing, the material upon which the 
job is printed.
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SWOP
The abbreviation for Specifications for 
Web Offset Publications. A standard of 
specifications for separations, proofs, 
and colour printing on a web offset press 
(not a sheet fed press).

TIFF (Tag Image File Format)
A common format for exchanging raster 
graphics (bitmap) images between 
application programs.

undercolour removal (UCR)
A method for improving wet ink 
trapping and reducing ink costs in 
process colour printing. In shadow areas 
where all three process colours (C, M, Y) 
overprint, the amounts of those colours 
are reduced and replaced by black.

vector graphic
Graphic illustration created on 
computers where picture objects are 
defined mathematically as lines or curves 
between points. These mathematical 
definitions are interpreted by an image 
language such as PostScript. Vector 
images include artwork created with 
illustration applications (such as 
Illustrator or FreeHand) and page layout 
applications (such as PageMaker).

white point
The colour temperature of any white 
light source, typically expressed in 
degrees Kelvin (for example, 6500 K, 
typical for the white of a monitor).

workflow
The path a print job follows from 
creation to destination. A workflow may 
originate with an RGB scan imported to 
the client workstation and opened on the 
desktop in an image processing 
application, such as Photoshop. After 
adjustments are made to the scanned 
image, it is evaluated on a colour 
proofing device for eventual colour 
printing on the same device or on press.
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